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Getting Started 
Electronic Filing 
 
Electronic filing is: 

1. Required when an entity or other person receives contributions or makes expenditures in excess 
of $50,000 in the current calendar year or has reason to expect to do so. 

2. Voluntary for any entity or other person that receives contributions or makes expenditures less 
than $50,000 in the current calendar year.  However, once a filer decides to e-file on a voluntary 
basis, it must continue to do so for the remainder of the calendar year, unless the Commission 
determines that extraordinary and unforeseeable circumstances have made it impractical for the 
filer to continue filing electronically. 

 
Electronic filing passwords: 

1. In order to request a password, you will need a FEC ID.  Because Independent Expenditure filers 
do not register with the FEC by filing a Statement of Organization (FEC Form 1), you will not 
receive your FEC ID until you have filed your first report.  You can file your first report on paper 
if you are below the $50,000 threshold for mandatory electronic filing or file electronically by 
using the online Form 5 webform for a non-registered entity or person(s) without a FEC ID.  
(Please note that once you use the webform, you are required to file all subsequent reports and 
documents electronically). 

2. Once you receive your FEC ID, you can obtain an electronic filing password from the Electronic 
Password Assignment System.   

3. For assistance with passwords, please consult the password help page or contact the FEC 
Electronic Filing Office by phone: 800-424-9530 (menu option #4) or 202-694-1307 or by email: 
eFiletechsupport@fec.gov.  

 
Downloading software: 
In order to download FECFile, you will need an FEC ID.  Because Independent Expenditure filers do 
not register with the FEC by filing a Statement of Organization (FEC Form 1), you will not receive your 
FEC ID until you have filed your first report.  You can file your first report on paper if you are below 
the $50,000 threshold for mandatory electronic filing or by using the online Form 5 webform for a non-
registered entity or person(s) without a FEC ID.  (Please note that once you use the webform you are 
required to file all subsequent reports and documents electronically). 

1. Go to https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/, and 
confirm Minimum System Requirements are met.    

2. Click Download FECFile Now.       
3. Enter your FEC ID and choose Submit. 
4. Enter the required information then click Submit. 
5. Click the FECFile X.X.X.X Download button. 
6. Follow your computer’s download instructions.   

https://webforms.fec.gov/
https://webforms.fec.gov/psa/getstarted.htm
https://webforms.fec.gov/psa/getstarted.htm
https://webforms.fec.gov/psa/help.htm
mailto:eFiletechsupport@fec.gov
https://webforms.fec.gov/
https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/
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7. Double-click the FECFile install icon and follow the installation prompts. 
4. Note: FECFile will automatically check for the latest program updates every time you start the    

software. If you are having trouble downloading FECFile, please contact the Electronic Filing 
Office by phone: 800-424-9530 (menu option #4) or 202-694-1307 or by email: 
eFiletechsupport@fec.gov.  

 

 
 
Video Tutorials 
 
Independent Expenditures: Introduction to Reporting 
 
Form 5: Setting Up Your Database in FECFile 
 
Form 5: Creating and Uploading 24 & 48 Hour Reports in FECFile  
 
Form 5: Entering Contributions, Expenditures and Uploading a Quarterly Report in FECFile 
 
Overview of Rules & Regulations for Independent Expenditures by Persons other than Political 
Committees 

 
Reporting Resources 
 
Reporting Independent Expenditures on Form 5 
 
Making Independent Expenditures 
 
Reporting Dates and Deadlines 

 

mailto:eFiletechsupport@fec.gov
https://www.youtube.com/watch?v=z0w-6FCHXMY&list=PLJr_nRe8SzD3-KLnokgzEDitoTyNFUAC4&index=1
https://www.youtube.com/watch?v=4MRgEUcAIro&list=PLJr_nRe8SzD3-KLnokgzEDitoTyNFUAC4&index=2
https://www.youtube.com/watch?v=23TcFhDr_eQ&list=PLJr_nRe8SzD3-KLnokgzEDitoTyNFUAC4&index=3
https://www.youtube.com/watch?v=M6uwVJVGzik&list=PLJr_nRe8SzD3-KLnokgzEDitoTyNFUAC4&index=4
https://www.youtube.com/watch?v=cVZ1flBNDr4
https://www.youtube.com/watch?v=cVZ1flBNDr4
https://www.fec.gov/help-candidates-and-committees/making-independent-expenditures/reporting-independent-expenditures-form-5/
https://www.fec.gov/help-candidates-and-committees/making-independent-expenditures/
https://www.fec.gov/help-candidates-and-committees/dates-and-deadlines/
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Using FECFile 
This section will lead you through the step-by-step process for setting up your electronic filing database 
(i.e., creating your “committee file” in FECFile), as well as creating your first Report of Independent 
Expenditures Made and Contributions Received (Form 5).  You will need to create the quarterly Form 5 
report before creating a 24 or 48 hour report (Form 5).  
 
Creating a New Committee File 
 

1. Start FECFile using either the desktop icon or the computer’s Start Menu. 
2. Click Create a new committee file. Use this file every time a report is created.  You should only 

create one committee file per Independent Expenditure entity. 
3. A window will appear to confirm the creation of a new committee file. Click OK. 

 
 
 

 
 
 
 
 
 
 
 

4. Choose the appropriate Form 5 (F5) filer type, Individual or Organization (shown below), from 
the following list and click OK.  (If your committee type files on the Form 3X, please use the 
Getting Started for PACs and Parties Guide instead of this guide.) 
 

 
 

 
 
 
 
 
 
 

https://transition.fec.gov/support/GettingStartedManual_U.pdf
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a. A system prompt will instruct you to enter the filer information.  Select OK and enter the 

FEC ID number (C9XXXXXXX), name, and address.  When finished, click OK. 
 

5. Click Yes at the prompt. 
 

 
 
 
 
 
 
 
 

        
 
    
   

Creating the First Report (Form 5) in a New 
Committee File 
Independent expenditure filers are required to file 
quarterly reports and 24/48 hour reports when 
necessary.  Filers will use the same process to create 
each of these types of reports. 
 

1. Once you have entered information about the 
Independent Expenditure filer, FECFile will 
prompt you to create your first quarterly report 
of Independent Expenditures Made and 
Contributions Received.  Select the Type of 
Report from the Report’s drop down menu. 

2. To sign the report, click in the Signed by box.  
Enter the name of the person completing the form 
(last name, first name).  If the individual has not already been entered into FECFile, press Tab or 
Enter. 

a. An “Individual/Organization” box will appear.  Ensure that the type selected is 
“Individual other than a Candidate” and enter the rest of the person's information (name, 
address, etc.). 

b. After entering the person's information, click OK to return to the Report Information box. 
3. After all the information is entered, click OK. 
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4. A window will appear, with options for what to do next in the report.  To view the Summary 
Page and begin to add transactions, click OK.  For more information, you can move to the 
section on "Entering Contributions" on page 11 or the section on "Entering Independent 
Expenditures" on page 12.  To view the Individuals/Organizations screen, click Cancel.  The 
FECFile Basics section on "Working with Contributors and Vendors" on page 9 will provide you 
information on entering contacts into your committee file. 

        
 
 
 
 
 
 
 
 

Creating a New Report in an Existing Committee File 
1. In the “View” menu, click Reports. 
2. In the “Edit” menu, click New, or right click anywhere in the Reports window and click New. 
3. Select the report type you would like to create "Report of receipts and Disbursements (Form 5)," 

"24 hour notice (Form 5)," "48 hour notice (Form 5)," or "Miscellaneous Electronic Submission 
(Form 99)" and click OK.  Do not use "Form 1" or "Form 1M."  For information on entering 24 
or 48 hour reports, please see page 14. 
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FECFile Basics 
 
Saving in FECFile: 
FECFile creates a database (with file extension .DCf), which holds the entirety of the entity’s reporting 
history.  This includes all reports, amendments, and contributors or vendors with whom the entity/filer 
works. 

1.  Save the file as often as possible.  This will decrease the chance of massive data loss.  Be sure 
to save the file in a location easily accessible and easily remembered. The FEC cannot recover a 
lost file. The FEC strongly recommends that you frequently back up the file to an external 
source, such as a cloud storage service, a flash drive, external hard drive, or CD.  
 

 
 
 
 
 
 

2. For each new report, open the same file that you created for the entity/filer.  Do not create a 
new file each time you want to create a report.  This will lead to problems with calendar 
year-to-date amounts and aggregate amounts.  The next time you open FECFile after creating 
you entity's file, you will be able to select the option to Always open this file when I open 
FECFile.  Checking this box will ensure you open the same file for each report.   
 

 
Using the Different Views: 
FECFile is organized into six different views or windows: Individuals/Organizations and Events; All 
Transactions; Reports; Summary Page – Form 5; Receipts; and Disbursements.  Each of these views 
displays a different aspect of reporting and is used to create and modify both reports and transactions.  
There are three different ways to access a view:  

1. When FECFile first opens, tabs will be displayed underneath the icon bar.  Click on the tab to 
access the desired view.  Tabs can be rearranged by dragging them to another location on the tab 
bar. 
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a. In order to view two tabs side-by-side, right-click on a tab and select Open in a 

Horizontal Tab or Open in New Vertical Group. 
b. Tabs can be closed by clicking on the “X” in the upper right-hand corner of the tab.   
c. New tabs can be opened or re-opened by using the “View” menu or clicking on the 

appropriate icon (see below for a list of FECFile Views).  To open all available tabs, click 
on Window in the upper left-hand corner and select Open All. 
 

2. Under the “View” menu, select the desired view: 

     
3. Click on the icon, located across the top of the screen, representing the view: 

   
About Each FECFile View: 

Reports View – This view lists all reports created in the committee file.  Transactions on these 
reports can be modified if the report is “open” (see page 18).  Reports also can be amended 
using this view by right-clicking on the report and selecting Amend. 
Summary Page – Form 5 View – This view shows both itemized (.I) and unitemized (.U) totals 
for this period (ThisP) and calendar year-to-date (CTD) for each line number.  Transactions 
may be entered on line numbers by double clicking a line. 

 
Individuals/Organizations and Events View – This view lists all entities entered into the 
database, including the information for the entity/filer making independent expenditures, 
contributors, other political committees, businesses, etc.  Modify an entity by double clicking on 
it. 
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Receipts View – This view lists all receipts entered in the report currently selected in Reports 
View.  Modify a transaction by double clicking it, or right click an entry for a list of options 
such as creating a new transaction, deleting a transaction, adding memo text, etc. 
Disbursements View – This view lists all independent expenditures entered in the report 
currently selected in Reports View.  Modify a transaction by double clicking it, or right click an 
entry for a list of options such as creating a new transaction, deleting a transaction, adding 
memo text, etc. 
All Transactions View – This view lists all transactions entered in the committee file.  
Transactions are sorted by line number and name. 

 

Memo Text: 
Memo text is used to provide additional information regarding reports and transactions.  Memo text can 
be added by highlighting the report or transaction, right-clicking, and choosing Memo Text… from the 
available options.  
 
Miscellaneous Electronic Submission (Form 99): 
A Form 99 is another way to provide additional information as a separate filing.  Go to the Reports tab 
and right-click and select New.  Then choose Miscellaneous Electronic Submission (Form 99) and click 
OK.  Enter the additional information, choose the treasurer’s name in the “Signed by” field and select 
“Miscellaneous Report to FEC” as the “Document Type.”  Follow the instructions on pages 17-18 to 
upload the Form 99. You can also electronically file a Form 99 using the online webform on the FEC’s 
website: https://webforms.fec.gov/  
 

Working with Contributors and Vendors: 
FECFile creates a database for all entities (individuals, businesses, PACs, Political Party Organizations, 
etc.) within the committee file.  This saves the filer from repeatedly entering the contributor or vendor 
information if it conducts multiple transactions with a particular entity. 
There are two ways to create an entity: 

1. When entering the first transaction associated with an entity, make sure the cursor is in the 
“Name” field and press Tab or Enter.  The “Individual/Organization Information” window 
will appear. 

2. Using the Individuals/Organizations view, right click anywhere in the workspace and click 
New from the available options.  The “Invididual/Organization Information” window will 
appear. 

 
Filling Out the Individual/Organization Information Box 

1. Select the correct entity type from the drop down menu at the top of the window. 
• Note: FECFile disables any field that is not required for a type of entity. 

2. After entering the information, click OK. 
 
 

https://webforms.fec.gov/
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Using the FEC “Lookup” Feature: 
Click Lookup… to access the FEC’s database of federally registered candidates and political committees.  
Use the feature to save time when entering information for a federal candidate or political committee. 

1. In the “Individual/Organization Information” box, click Lookup… 
2. The “FEC ID Lookup” window appears.  Scroll through the list and click once on the entry to 

highlight it.  You can also type the name of the candidate or committee in the name field and 
then select Lookup to navigate to that entry. 

3. Copy all applicable information by clicking Copy All….  
4. Unchecking boxes in the window that appears will exclude that information from copying to the 

entity record.  Click OK, and all of the checked information will be copied into the entity record.   

5. Click OK to return to the transaction screen. 
 

 



 

FECFile Training Manual 
Page 11 

Entering Contributions 
 
 

1. Click the “Summary Page” icon at the top of FECFile.  In the “Summary Page” window, double 
click on Line 6 to enter a contribution.    

        
2. Click on the name in the list scroll box 

immediately beneath the name field if the 
entity already exists in the filer’s FECFile 
database.   If the entity is not in the database, 
press Tab or Enter to add the information.  
Refer to page 9 for more information. 

3. Enter date and amount. 
4. Click OK. 
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 Entering Independent Expenditures 
 

1. Go to the “Summary Page” view and double-click on Line 7. 
 

         
 
 
 
 
 
 
 

2. An Independent Expenditure box will 
appear.  

3. Select the payee’s name from the scroll 
box below the “Name” field.  If the 
entity is not in the database, press Tab 
or Enter to add the information. 

4. Complete the dissemination date, 
amount, and description information.  
For an explanation of what constitutes 
the dissemination date, see the Form 5 
instructions on the FEC website. 

5. Indicate whether the independent 
expenditure supported or opposed the 
candidate.  If the candidate is already in 
the dropdown box, you can select that 
person.  Otherwise, hit Tab or Enter to 
create an Individual/Organization 
record for that candidate. You can then 
enter the candidate information or use 
the "FEC Look-up Feature."  Please 
refer to page 9 for more information 
about the "FEC Look-up Feature."     

6. Enter the category code, select the 
election type, year of election, and the 
candidate’s office sought, state and 
district (if applicable).  For more 
information about the category code, 
please see the Form 5 instructions on the 
FEC website.  When reporting independent expenditures made in connection with separate 

https://transition.fec.gov/pdf/forms/fecfrm5i.pdf
https://transition.fec.gov/pdf/forms/fecfrm5i.pdf
https://transition.fec.gov/pdf/forms/fecfrm5i.pdf
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elections in more than one state, allocate the cost of the independent expenditure and create a 
separate entry for each state and election. 

7. Click OK.  
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24 and 48 Hour Reports 
 

Creating 24 and 48 Hour Reports 
24 and 48 hour reports are separate filings from Form 5 quarterly reports.  Both are required to be filed 
when the independent expenditures exceed the thresholds described in the Form 5 instructions on the 
FEC website. 
 

1. To prepare to create a 24 and/or 48 hour report, first create the Form 5 quarterly report for the 
calendar year quarter during which the independent expenditures were made.  See page 6 for 
instructions on "Creating a New Report in an Existing Committee File." 

2. To create a 24 hour report, go to the “Reports” view, right click on the white background, and 
click New.  Click “24 hour notice (Form 5)” and click OK. 
 
 
 
 
 
 
 
 
 
 
 

3. To create a 48 hour report, go to the “Reports” view, right click on the white background, and 
click New.  Click “48 hour notice (Form 5)” and click OK. 

 
 
 
 
 
 
 
 
 
 

https://transition.fec.gov/pdf/forms/fecfrm5i.pdf
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4. The “24 hour Report” or “48 hour 
Report” box will appear; fill in the 
election date, the state, and enter the 
filer’s information in the “Signed by” 
box.  All fields are required.  If the 
report includes independent 
expenditures made in more than one 
state, please enter any one of the 
applicable states (this information is 
currently required in FECFile, but will 
not appear on the coverage page of your 
report).   

5. Click OK.  Note that at this point the 
24/48 hour report is not complete until 
an independent expenditure is added to the report. 

 
 
 

Adding Independent Expenditures to a 24 or 48 Hour Report 
6. Select the “Reports” view and select the 24 or 48 hour report by clicking on it. 
7. Select the “All Transactions” view and locate the independent expenditure(s) that needs to 

appear on the 24 or 48 hour report.  If you do not see the "All Transactions" tab open, select 
"View" in the upper left-hand corner to open the tab.  Independent expenditures that have been 
entered will show up on Line 7 in alphabetical order. 
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8. After finding a transaction, select the entry, right click, and click Add to 24 hour Report or Add 
to 48 hour Report. The Independent Expenditure transaction box will open with the previously 
entered information.  Make sure the information for the transaction is correct and click OK to 
add to the notice.  Repeat this step until all of the required independent expenditures have been 
added to the 24 or 48 hour report.     

9. The 24 or 48 hour notice is now complete.  Close and upload it in the same manner as a regular 
Form 5 Quarterly Report (see page 17). 

10. Please note, if an entity has filed a 24 or 48 hour report, it must also file a separate quarterly 
report for that calendar year quarter (even if the independent expenditure information is 
identical). 
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Closing/Uploading/Amending 
 

Closing a Report 
1. Go to the “Reports” view. 
2. Right click on the report and click Close Report. 

 
 
 
 
 
 
 
 
 

3. Enter today’s date in the “Date closed” field and 
click OK.  (Note: a Filing ID is only required when filing amendments and should be left blank 
for new reports.) 

 

Uploading a Report 
1. First, follow the directions above for closing a report.  

(Closed reports should appear in pink/purple in the 
“Reports” view) 

2. IMPORTANT:  Save the file before  uploading!  
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3. Click Upload from the “File” menu, or click the 
Upload icon.  

  
4. Enter the password (see page 2), 9-digit FEC ID 

number, and email address.  You must confirm the password and email address by entering them  
a second time or the report will not  upload.  

5. Unless otherwise directed by the FEC’s Electronic Filing Office, leave “Web service” as the 
Filing Method and then click Submit Filing to FEC.  (Note: “This filing amends” field should not 
be filled in for new reports.) 

6. Save the committee file after the report uploads.  

 

Amending a Report 
Amend a report when changes need to be made to a report that has already been uploaded.  If the report 
has not yet been uploaded, right click on the report to unclose it and make the necessary modifications. 
 
Creating an Amendment: 

1. Go to the “Reports” view. 
2. Right click the report to be amended and then click Amend. 
3. Click OK on the “Report Information” box and 

click YES when prompted "Are you sure you want 
to modify the selected Report?" 
a. Note: reports originally filed on paper before 

the filer crossed the electronic filing threshold 
cannot be amended electronically. 

b. The report will now have an A1, A2, etc. in front of it.  A1 is for the first amendment, A2 is 
for the second amendment, and so on 

c. Note: these reports will automatically be generated, but not automatically uploaded.  Also, 
these additional amendments need not be uploaded unless there is a change in any of the 
dollar figures (most commonly: calendar year-to-date or aggregate totals).  If there are any 
changes in the dollar figures for subsequent reports, please upload those reports as well. 

https://webforms.fec.gov/psa/getstarted.htm


 

FECFile Training Manual 
Page 19 

 
 
Modifying Transactions for the Amendment: 

1. Locate the transaction you want to modify from the "Receipts," "Disbursements," or "All 
Transactions" tab. 

2. Double click on the transaction. 
3. Make the desired changes to the transaction and click OK. 
4. When prompted, click Yes to modify the selected transaction. 

 
Adding New Transactions for the Amendment: 

1.  As with a new report, go to the “Summary Page” view and double click on the appropriate line 
 for that transaction. 
2.   Enter the transaction information and click OK. 

 
Deleting Transactions from an Amended Report: 

1. Locate the transaction you want to delete from the 
"Receipts," "Disbursements," or "All Transactions" 
tab. 

2. Right click on the transaction and click Delete. 
3. When prompted, click Yes to delete the selected 

transaction. 
 
Filing an Amended Report:  

1. An amended report is filed like a new report:  Close the report, and then choose Upload from the 
File menu. 

2. If the original report was created using FECFile, the 
software will automatically fill out the “Filing ID” field.    

a. Do not alter this number unless instructed by an 
FEC analyst or the FEC’s Electronic Filing Office. 

b. If instructed to alter the number, or if the number 
does not appear in the box, the filing ID is located 
on the FEC’s website 
(https://www.fec.gov/data/filings/).  Search your FEC 
ID number.  The Filing ID appears under the “Version” column. 

 

https://www.fec.gov/data/filings/
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Secrets to FECFile 
 

Common E-Filing Mistakes! 
 
Passwords  
• Remember to obtain an electronic filing password as soon as possible. Due to the extra security 

requirements, it may take up to two business days for the FEC to complete electronic filing password 
requests. 

• Don’t wait until the last minute to apply for a password or to apply for a new one if necessary. 

• Remember the entity/filer's password and keep it secure:  the FEC cannot look up misplaced or 
forgotten passwords; the report filer must request a new one. 

Filing at the last minute 
• Any problem, whether it’s technical or non-familiarity with the software, can be difficult to deal 

with during the rush of a deadline week.  It is advisable to always file as early as possible, especially 
the first time the entity files electronically. 

• Be aware of upcoming reports. Please consult the Dates and Deadlines page and Reporting 
Independent expenditures on Form 5 page. 

 

Email receipts confirm filing has been received 
• After uploading the report electronically, a receipt will be sent to the email address entered when 

uploading the report.  Assume that the report was not successfully filed if no receipt is received. Call 
the Electronic Filing Office (202-694-1642, Option #3) if more than a few minutes pass without 
receiving a receipt. 

• The receipt is proof of filing.  Print it out and keep it. 

• You can look up your entity’s filings at any time using the FEC website: 
https://www.fec.gov/data/filings/?data_type=efiling 
 

Save and validate data set early and often 
• Doing this through the process of report creation will ensure proper and consistent data entry as well 

as prevent the loss of work due to unforeseen computer problems, i.e., freezes, crashes, etc.  

Back up the data file! 
• The file that contains all of the entity/filers reports, the “Data File” (*.dcf), should be backed up to 

an external source. 

• It is very difficult and time consuming to recreate the committee file if it is lost. 

http://classic.fec.gov/elecfil/mistakes.shtml
https://webforms.fec.gov/psa/getstarted.htm
https://www.fec.gov/help-candidates-and-committees/dates-and-deadlines/
https://www.fec.gov/help-candidates-and-committees/making-independent-expenditures/reporting-independent-expenditures-form-5/
https://www.fec.gov/help-candidates-and-committees/making-independent-expenditures/reporting-independent-expenditures-form-5/
https://www.fec.gov/data/filings/?data_type=efiling
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Common Validation Errors and How to Fix Them 
 

Warning vs. Error Messages 
There are two different types of validation errors: warning messages and error messages.   
Warning messages: 
These messages are a result of possible incorrect/missing information in the report.  The user can choose 
to correct the issues before uploading the report.  However, these warnings do not prevent the filer from 
uploading a report.  
Error messages: 
These messages result from more serious problems and prevent the user from uploading the report until 
the errors are corrected. 
 

Reading and Understanding a Validation Message 
Each warning or error message contains basic information that allows the user to pinpoint which 
transaction is causing the issue.  It also gives a brief description of the error.  For example: 
 

Form{Item}:  F56   {Johnson} 
Field Name:  #011  Contributor Street 1 
Warning     is Required, but field is Empty 

 
The Form {Item} field identifies where the transaction causing the error is on the report.  In the 
example above, the transaction is on Form 5, Line 6 and is specifically identified as “Johnson.”  Field 
Name identifies the aspect of the transaction – in this case the  street address field for the contributor – 
that is causing the problem.  The last line identifies what type of message this is (Warning) and 
describes what caused the problem (is Required, but field is Empty). 
 
In order to correct this problem, the user should find the specific transaction and edit it to disclose the 
street address for the contributor with the last name Johnson. 
 
The FEC’s website includes a more extensive list of commonly found warning and error messages along 
with brief descriptions and solutions.  
https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/   

https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/
https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/
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Common Error Messages 
Below is a list of common error messages that committees encounter and the steps that need to be taken 
in order to correct the errors.  Please remember that all error messages must be corrected before you can 
upload your report. 
 

Filing must be in the current FEC format 

• This indicates that you are using an outdated version of FECFile. 

• FECFile users will need to download the latest version of the software from the FEC's website 
(https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/). 
 

Amended filing must have an ID of the "Original"  

• This indicates that the user is trying to submit an amendment absent the original report ID 
number. The original report ID number must be used.  If you are properly amending existing 
reports in the committee file, the original filing ID should appear automatically. 

• If the user cannot locate his receipt for the original report, the ID number can be located on the 
FEC's Electronic Filing Report Retrieval website under the “Version” column 
(https://www.fec.gov/data/filings/). 

• Once you have located the original filing ID, you will need 
to open, and then re-close your report so you can enter the 
filing ID (see right). 

• NOTE: If this original report ID number is entered 
incorrectly, system errors will occur on upload. 

 
Amended filing must have an "Amendment Number"  

• This means that either the 
amendment indicator is missing or 
incorrect.  The first amendment 
will be A1, and each subsequent 
amendment will be numbered in 
sequence.    

• This error most likely occurred 
because you did not properly create an amendment or amended a report before it was filed. 

• Don’t amend a report that you have not uploaded.  FECFile will warn you with this message – 
click Cancel.  

 

• In the “Reports” view, right click on the report you are trying 
to file.  If the report is closed, unclose it.  Right click again and click 
Unamend. 
 

https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/
https://www.fec.gov/data/filings/
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• Repeat this process until your report is at the correct numbered amendment 
 
 
 
Validation terminated! – Over 32,000 problems found!  

• This indicates that 32,000+ errors have been found.  The threshold for total errors for the system 
is 32,000; therefore, the first 32,000 errors will be listed in accordance with their severity. 

• If you receive this message please contact your reports analyst or the FEC electronic filing 
office. 

 
ID# _________ NOT correct FEC ID# format  

• This indicates that the FEC ID number used 
is not in the correct format. 

• To correct this error, you will need to edit 
your FEC ID number.  To do this, go to the 
“Individuals/ Organizations” view and locate 
your filing entity.  Double-click on your 
entity name (it should be in red).  Make sure 
the FEC ID number is correct.  It might help 
to use the FEC Lookup feature. 

• NOTE: (correct example: C91234567) - The 
“C” must be capitalized. 

 
{Field) is required, but field is empty  

• This indicates that information is required to be entered in a particular field, but has not been. 

• Locate the transaction and fill in the field. 
 
Extraneous data follows last field  

• This usually indicates a technical problem, generally involving invalid characters. 

• You should call the Electronic Filing Office if you receive this error (800-424-9530 Ext. 1307). 

• NOTE: Only characters between ASCII 22 and ASCII 126 are acceptable.  The ASCII 32 - 126 
used to be the only characters allowed; however, the foreign language alphabet and punctuation 
characters are also allowed. Specifically, ASCII characters 32 - 168 are allowed (excluding 127 
and the series 157 through 159).  Also, 173 is allowed. 

 
Invalid double-quote surround text field – OR - Embedded double-quotes (") not allowed  

• This indicates that there are a set quotes around a text field where there should not be. 

• Locate the transaction/field and take out the quotes. 
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• NOTE: Quotes are used as part of the data delimiter.   Since the introduction of a level-8 
message that says "Embedded double-quotes (") not allowed", this message only applies to the 
very last field of a CSV string and only in the instance where a begin-quoted text is not 
terminated with an end-quote. (Example: falling within the maximum length of that last field.) 

• ADDITIONAL NOTE: Any field can have begin/end quotes (they are necessary for text that has 
embedded commas). However, any field that has surrounding quotes may not also contain 
double quotes anywhere within the text.  Validator is only trapping "embedded quotes" within 
"text fields" which have surrounding begin-quotes and end-quotes. For example [,""",] is a case 
of an embedded double-quote, but [,",] is not. 

 
Body of text exceeds maximum of 20,000 characters (F99 filings) 

• F99 (Miscellaneous text document) filings are limited to 20,000 characters in length. 

• To correct this, either shorten your Form 99 filing or file more than one. 
 
Leading blanks {e.g. " TEXT"} not allowed  

• This indicates that there are blanks prior to data; this is not allowed. 

• Locate the transaction/field and delete the spaces that precede the first word in the file. 
 
Bad date – ________ not YYYYMMDD format  

• This indicates the user has entered a date in the incorrect format. 

• Locate the transaction and re-enter the date trying this format: MM/DD/YYYY. 
 

________ is not a real date  

• This indicates that the user has entered an invalid date. 

• Locate the transaction and enter a valid date. 
 
Invalid amount format: ____________ – OR – Non-numeric data in numeric field 

• This indicates that the user has entered values other than 
numbers and decimals. 

• Locate the transaction and enter only numbers and one decimal 
point.  FECFile will issue a warning before this error is made. 
(See right) 

• NOTE: Dollar signs and commas are not permitted. 
 
____ is an invalid year (CCYY) format  

• This indicates the user has entered the year in the incorrect format. 
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• Locate the transaction and make sure the year referenced in the date field is in a four-digit 
format. 

 
District "__" is not 2-digit numeric format  

• This indicates the user failed to enter the congressional district as two digits. 

• Locate the transaction, and make sure the congressional district field has two digits (ex: 04, 11).  
Using the FEC Lookup feature might make things easier. 
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